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Abstract

This study presents a new method of estimating the size distribution of river bed gravel through image processing. The analysis was done 

in two steps; first the individual grain images were analyzed and then the grain particle segmentation of river-bed images were processed. 

In the first part of the analysis, the relationships (long axes, intermediate axes and projective areas) between grain features from images and 

those measured were compared. For this analysis, 240 gravel particles were collected at three river stations. All particles were measured 

with vernier calipers and weighed with scales. The measured data showed that river gravel had shape factors of 0.514~0.585. It was found 

that the weight of gravel had a stronger correlation with the projective areas than the long or intermediate axes. Using these results, we were 

able to establish an area-weight formula. In the second step, we calculated the projective areas of the river-bed gravels by detecting their 

edge lines using the ImageJ program. The projective areas of the gravels were converted to the grain-size distribution using the formula 

previously established. The proposed method was applied to 3 small- and medium- sized rivers in Korea. Comparisons of the analyzed size 

distributions with those measured showed that the proposed method could estimate the median diameter within a fair error range. However, 

the estimated distributions showed a slight deviation from the observed value, which is something that needs improvement in the future.
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영상 처리에 의한 하상자갈의 입도분포 분석

류권규a*ㆍ조우성b

a동의대학교 토목공학과 부교수, bGT엔지니어링 계장

요  지

본 연구의 목적은 영상 처리를 통하여 자갈 이상의 조립질 재료로 이루어진 하상의 입도 분포를 추정하는 기법을 개발하는 것이다. 전체 과정은 개

별 입자의 영상 분석과정과 혼합 입경으로 이루어진 하상 영상에서 입자를 추출하고 분석하여 입도 분포를 추정하는 두 과정으로 이루어졌다. 먼저 

개별 입자들의 영상에 나타난 평면 특성(장축, 중간축, 면적 등)이 실제 입자와 어떤 관계를 가지는지 분석하였다. 이를 위하여, 3개 중소하천에서 

240개의 자갈 시료를 채취한 뒤, 각 입자의 장축, 중간축, 단축의 길이와 중량을 측정하였다. 또, 채취된 입자를 하나씩 촬영하여 영상을 만들고, 영

상에서 장축과 중간축, 투영면적을 계측하였다. 영상에서 계측된 정보와 버니어 캘리퍼스와 저울을 이용하여 실제 측정한 자료를 비교하였다. 입

자의 개별 측정 결과 자갈 하천의 하상 재료의 형상계수는 0.514~0.585 이었다. 또한 자갈의 중량은 장축이나 중간축보다는 투영면적과의 상관

성이 더 높다. 따라서 영상의 투영면적에서 중량을 산정할 수 있는 관계식을 작성하였다. 또, 자갈하상을 촬영한 영상에서 ImageJ 프로그램를 이용

하여 입자 하나하나의 윤곽을 검출한 뒤, 입자의 투영면적을 산출하였다. 그리고 투영면적과중량의 관계식을 이용하여, 중량입도분포를 추정하는 

방법을 제시하였다. 제안된 방법을 3개 하천에 적용해 본 결과 비교적 상당한 정확도로 자갈의 입도분포를 추정할 수 있었다. 다만, 추정된 입도곡

선에서 일부분은 실측된 입도곡선과 차이를 보였으며, 이는 추후 개선되어야 할 부분이다.

핵심용어: 하상 자갈, 입도 분포, 영상 처리, 형상계수, 윤곽 검출
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1. 서  론

하상재료의 입도 분포는 하상의 조도를 예측하거나, 유역

의 토사 유출량을 토사수리학적으로 산출하거나, 이동상 수

로의 거동을 예측하는 데, 나아가서는 하도 계획을 수립하거

나 생태 서식처를 결정하는 데도 필수적인 정보이다(Chung 

and Chang, 2013). 이 때문에 우리나라에서는 하천관련사업

을 시행하는 데 가장 기본적인 과정인 하천 조사와 하천정비

계획에서 반드시 하상재료의 입도분포를 조사하도록 하고 있

다(KWRA, 2009). 

이 때 하상 재료의 입도 분포에 따라 Fig. 1과 같이 매우 다양

한 방법이 존재하며(Kondolf and Piégay, 2003), 우리나라에

서는 세립질(실트와 점토)는 침강속도법, 중립질(모래, 잔자

갈)은 체분석, 조립질(자갈, 호박돌, 거력 등) 이상은 격자틀을 

이용한 현장 측정을 하도록 권고한다(KWRA, 2009). 여기서 

제시된 방법 이외에도 세립질 재료의 입도 분석에는 레이저 

회절이나 X선 회절법을 이용하기도 한다. 그래서 모래 하천

의 경우에는 체분석이 거의 유일한 방법으로 이용되고 있다. 

그런데, 문제는 자갈하천과 같이 조립질 하상재료로 이루어

진 하천에 대해서도 체분석을 그대로 이용한다는 것이다.

한편, 자갈 하천의 대표입경을 구하기 위해 체분석 대신에 

이용하는 방법으로는 선격자법, 면격자법, 용적법, 자갈 계수

법 등이 있다. 면격자법은 특정 대표지점에서 격자틀을 이용

하여 줄의 교차점에서 재료를 채취하는 방법이며, 선격자법

은 하상위에 줄이나 자 등을 직선으로 늘어뜨리고, 일정 간격

으로 줄이나 자의 바로 아래에 있는 재료를 채취하는 방법

(KWRA, 2009)이다. 또 용적법은 폭 및 길이가 약 0.5 m의 범

위안의 모든 재료를 채취하는 방법이며, 자갈계수법(pebble 

counting)은 무작위로 걸으면서 일정 거리마다 발끝에 걸리

는 자갈을 주워서 개수를 세는 방법이다. 이들 방법은 각각 특

징과 장점 및 단점이 있다(Kellerhals and Bray, 1970).

그런데 자갈 이상의 하상 재료로 구성된 하도(이른바 자갈

하천)를 살펴보면, 하상 재료의 입경 분포를 분석하는 데 몇 

가지 문제가 존재한다. 

첫째는 최대 입경이 너무 큰 경우 모래 하천에서 사용하는 

체분석을 사용하기 곤란하다. 자갈 하천에 체분석법을 적용

할 때의 기본 원칙은 시료 한 개가 전체 시료 중량의 1%를 넘지 

않아야 한다는 것이다(Church et al., 1987). 이 기본원칙을 지

켜서 채취해야 할 시료의 양을 수식으로 나타내면, ASTM 

(American Society of Testing of Materials)의 C136-71에 다

음과 같이 제시되어 있다. 


max

 (1)

여기서 : 시료 중량(kgf), 
max

: 시료의 최대 중간축 크기

(mm)이다. 이 식은 KWRA (2009)의 하천설계기준에도 똑같

이 제시되어 있다. Eq. (1)에 따르면 최대 시료의 중간축이 200 

mm인 하상 재료로 된 자갈 하천에서 체분석 시료를 채취하려

면, 약 220 kg을 채취해야 한다. 이처럼 많은 시료는 채취 자체

도 힘들고, 운반과 분석도 곤란하다. 따라서 현장에서는 많은 

경우 이 규정을 제대로 따르지 않는 것으로 보인다. 

이런 예는 국내의 하천기본계획 보고서나 관련 자료 등을 

Fig. 1. Analysis method for various riverbed materials (Kondolf and Piégay, 2003)
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보면 대부분의 입도조사는 자료값과 현장과의 상당한 큰 차이

가 난다. 예를 들어 Fig. 2와 Table 1은 본 연구에서 시험 대상으

로 선정한 대종천, 형산강, 밀양강의 지점의 하상재료를 보여

준다. 현장 사진에서는 중앙입경이 비교적 큰 자갈로 이루어

진 하상이지만, 하천기본계획 보고서에는 중사나 조사 정도

의 크기인 몇 mm 정도로 제시되어 있다. 그 이유는 현장의 하

상재료가 자갈인 경우, 체분석을 실시할 경우 채취할 시료의 

양이 방대하기 때문에 실무자들이 그만한 양을 채취하지 못하

고, 일부 모래가 있는 지점의 시료만 선별하여 채취한 것이 아

닌가 추정된다.

둘째 문제는 하도의 평면에서 보았을 때, 하상 재료의 입도 

분포에 공간적인 편차가 존재한다. 즉 좌우안, 주하도 등 한 횡

단면에서도 좌우의 위치, 흐름의 상하류 상황에 따라 입도 분포

가 현저하게 다른 경우가 많다. 이 때문에 매우 많은 양의 시료

를, 공간적으로 매우 넓은 범위에서의 조사하여 대표 입경을 결

정할 필요가 있다. 이처럼 조사의 공간적 범위와 표본 채취 빈도

가 늘어나면, 이에 비례하여 작업량이 엄청나게 증대되는 것이 

문제이다(Ohasi et al., 2010; Nakaji, 2012). 

2. 기존의 영상 입도분석법

따라서 이를 해결하기 위한 방법으로 영상 처리를 이용한 

조립질 하상의 입도분포 추정법이 많이 연구되었다. 영상을 

이용한 입도분석방법은 크게 수동입도분석(MGS, manual 

grain sizing)과 자동입도분석(AGS, automatic grain sizing)

으로 나눌 수 있다. 두 방법 모두 혼합 입경의 하상을 사진 촬영

하고, 촬영된 영상의 영상 처리를 통하여 하상 재료 입자의 윤

곽을 추출한 뒤, 이를 등가의 구나 타원체로 가정하여 입도를 

환산하는 방법이다. 다만, 수동입도분석은 이를 캐드와 같은 

프로그램으로 수작업으로 입자의 윤곽선을 분리하고, 자동

입도분석은 영상처리용의 특별한 프로그램을 이용하여 자동

으로 입자의 윤곽선을 분리하는 차이가 있다. 수동입도분석

에 대한 연구는 Kuroda et al. (2005), Uchio et al. (2005), 

Ohasi et al. (2010) 등 일본에서 다수의 연구가 수행되었다. 

한편 자동입도분석은 재료의 크기에 따라 다른 방향으로 

발전해 왔다. 모래 정도의 세립질 또는 중립질 재료에 대해서

는 상호상관법(cross correlation)을 이용한 방법이 주로 이용

되며, 자갈 이상의 조립질 재료에 대해서는 입자 분리를 이용

한 방법이 주로 이용되었다. 앞서 Fig. 1에 하상재료의 크기별

로 적합한 분석 방법을 제시한 바 있다.

그래서 자갈 하천의 하상재료 입도를 보다 간편하게 영상

을 이용하여 분석하는 방법으로 제시된 것이 영상입도분석법

이다. 영상입도분석법은 1970년대부터 제시된 사진체법

(photosieving)이 효시라 볼 수 있으며, 1990년대의 개인용 컴

퓨터의 발달과 영상 처리 기술의 발달과 더불어 활성화되었

다. 2000년대 들어서는 자갈의 크기를 자동인식하는 자동입

도분석(AGS, Automated Grain Sizing)법이 대두되었으며, 

Butler et al. (2002), Graham et al. (2005), Harb and Schneider 

(2009), Strom et al. (2010) 등의 연구가 있다. 또한 2019년 현

재 이를 위한 상용 소프트웨어도 시판되고 있다. 그럼에도 불구

하고, 자동입도분석법은 여전히 많은 한계를 지니고 있다. 우

(a) No.60 of the Daejong River (b) No.50 of the Hyungsan River (c) No.65 of the Milyang River

Fig. 2. Riverbed materials at test sites

Table 1. Comparison of bed material sizes in river masterplan reports and actual states

river
report of river master plan

D50 estimated at sites with eyes (mm)
report section no. of grains D50 (mm) Dm (mm)

Daejong Kyongsangbukdo (1997) No.59 120 4.189 7.858 over 50

Hyungsan City of Ulsan (2002) No.50 60 about 7 - over 50

Milyang MLTMA (2009) No.65 60 0.16 0.62 over 70
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선 자갈을 자동 인식하는 과정에서 자갈의 형상, 색, 촬영 조건 

등에 따라 검출 정확도가 크게 좌우되며, 이 때문에 보다 견고한 

알고리즘 개발의 여지가 많이 남아 있다. 또한 이런 기법이나 

소프트웨어들은 그 결과를 입자의 면적 분포로 나타낸다. 반면, 

우리나라에서는 하상재료의 입도분포를 입경과 누가중량분

포의 관계로 나타내므로, 위 기법들을 그대로 적용할 수 없다. 

이 때문인지 국내에서는 이러한 관련 연구는 그다지 활발

하게 진행되지 않은 것으로 보인다. 국내에서 영상을 이용한 

자갈의 입도분석에 대한 연구는 Hwang et al. (2010)과 Lee 

et al. (2011)의 연구가 있다. 이들은 시공현장에 적용하기 위한 

골재의 입도 분석을 위한 연구를 하였다. 먼저 채취한 시료를 

영상으로 촬영하고, 타원회전체 가정에 입각하여 입도를 추

정하는 방법을 제시하였다. 이 때문에 분석된 입자들은 현장

에 놓인 혼합상태의 입자들이 아니라 입자 하나하나를 개별적

으로 분석한 것이다.

반면에, 본 연구는 자갈 이상의 조립질 재료로 이루어진 하

상의 입도 분포를 별도의 시료채취과정없이 영상 처리를 통하

여 추정하는 기법을 개발하는 것이다. 즉, 시료를 채취하고 분

석하는 과정이 없이 단순히 사진촬영에 의해서만 입도를 분석

하는 데 주안을 두는 것이다.

3. 영상 입도 분석

3.1 입자의 크기

개별적으로 입자를 영상 분석할 경우, 영상에서는 평면적

인 정보밖에 얻을 수 없기 때문에, 단축의 길이, 체적이나 중량

과 같은 3차원적인 정보는 일부 추정하여야 한다. 따라서 먼저 

다른 AGS 방법들이 채택하고 있는 3차원 회전타원체 가정의 

타당성을 검토해야 한다.

먼저 회전타원체(ellipsoid, 이후 간략히 ‘타원체’라 부르

기로 한다)의 체적을 검토해 보자. 타원체의 정의는 좌표축에 

대해 대칭이고, 단면이 타원 또는 원인 기하학적 표면을 말한

다. 타원체의 체적은 다음과 같다.





(2)

여기서 : 장축의 반지름, : 중축의 반지름, : 단축의 반지

름이다. 만일 지름을 이용하여 나타내면 다음과 같다.





(3)

여기서 : 장축의 지름, : 중축의 지름, : 단축의 지름이

다. 또한 타원체의 표준 공식은 다음과 같다.






















 (4)

이 때 형상계수(shape factor) 는 다음과 같이 정의한다.

 







(5)

자연하천의 경우 모래 입자의 형상계수는 0.7 정도로 알려져 있

으며, 자갈하천의 경우 이보다 작은 값을 가지는 것이 일반적이다. 

한편, 자갈이 하상에 놓일 때 단축이 하상면과 수직이 되게 

놓인다고 가정할 수 있다. 즉, 투영 영상에서는 자갈의 장축과 

중간축을 보게 된다. 이런 연직투영면(단축 길이 를 연직 

방향)에서 타원체를 보면 다음과 같은 타원(ellipse)이 된다.















 (6)

Eq. (6)으로 주어진 타원의 면적은 다음과 같다.

 (7)

만일, 를 안다면 영상 분석에서 측정되지 않는 단축의 반

지름 는 다음과 같이 추정할 수 있다.

   (8)

또한 이에 따른 체적과 중량은




 





 


(9)




 





 





 




(10)

여기서  : 중력가속도(= 9.8 m/sec2)이며, : 자갈의 밀도로 

하상 재료가 석영질 재료라고 가정하면, 2,650 (kg/m3)의 값
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을 갖는다. Eq. (10)에서 중량은 투영단면적의 3/2 승에 비례

하는 관계를 갖는다. 다만, Eqs. (1) ~ (10)은 본 연구에서 중량

을 추정하는 방법과 비교를 위해 제시한 것이며, 본 연구에서 

실제 사용하는 것은 아니다.

3.2 입자 크기의 영상 분석

본 연구에서는 다른 연구들이 채택한 3차원 회전타원체 가

정을 이용하지 않고, 개별 입자의 특성을 영상 분석하고, 추후 

하상사진에서 개별 입자를 추출하여 분석하는 방법을 이용하

기로 하였다. 이 방법은 Cho (2014)가 제안한 것이다. 

이를 위해 개별 입자의 영상적인 특징을 분석하였다. 즉, 입

자 하나하나의 영상적인 특징과 실제 특성의 관계를 만들어 

내는 것이다. 영상에서 추출할 수 있는 특징은 장축의 길이, 

중축의 길이, 투영면적의 크기 세 가지이다. 이 영상 특징을 

분석하는 과정은 다음과 같다.

① 하천에서 다량의 시료를 채취하여 실험실로 운반한 다

음, 입자 하나하나를 Fig. 3(a)와 같이 사진으로 촬영한

다. 영상 하나를 화면에 읽어들인다. 본 연구의 시험에서

는 대종천, 밀양강, 형산강의 3개 하천에서 총 240개의 

자갈을 채취하였다.

② 이 영상에 Fig. 3(a)와 같이 적당한 크기의 관심영역(ROI, 

Region Of Interest)를 설정하고, 이 부분을 잘라낸다. 

③ 잘라낸 영상을 회색 영상으로 변환하고, Fig. 3(b)와 같

이 Canny 윤곽선 검출(edge detection)을 한다. Canny 

윤곽선 검출은 윤곽선 검출 방법 중에서 가장 보편적으

로 사용되는 방법중 하나이다. 

④ 바깥에서 사각형을 좁혀 들어오면서, 윤곽선의 수평 및 

연직 방향의 최대 및 최소 위치(상하좌우)를 결정한다. 

또 이 때 입자의 면적도 결정한다. 입자 면적은 영상의 

전체 화소수에서 윤곽 바깥쪽 화소수를 빼면 된다.

⑤ 이 영상을 일정 간격(여기서는 1° 간격)으로 90°까지 영상

의 중심을 회전축으로 하여 회전시키면서, 윤곽선의 수평 

및 연직 방향의 최대 및 최소 위치(상하좌우)를 결정한다. 

⑥ 위의 ⑤에서 찾아낸 상하 방향(또는 좌우 방향)의 최대값

이 입자의 장축이고, 이 때 대응되는 좌우 방향(또는 상

하 방향)의 값이 입자의 중간축이다.

이와 같은 과정을 거쳐, 각 입자의 장축, 중간축, 면적을 계

산하였다. 

3.3 영상 분석에 의한 개별 입자 특성 분석

앞의 3.2절에서 영상 분석한 입자 모두에 대해 버니어캘리

퍼스와 전자저울을 이용하여, 장축, 중간축, 단축, 중량을 측

정하였다. 그리고 이렇게 만들어진 두 종류의 자료(영상분석

자료와 실측자료)에서 영상에서 계산된 세 변수가 측정된 중

량과 어떤 관계를 갖는지 유도하였다.

개별 입자의 영상 특성 분석을 위해 대종천, 형산강, 밀양강

의 3개 하천 3개 지점에서 총 240개의 시료를 채취하였다. 이 

시료들을 분석한 결과 Table 2와 같은 결과를 얻었다.

Table 2에 보인 것처럼 대종천, 밀양강, 형산강의 3개 하천

은 여러 가지 하천 특성이 매우 비슷한 경향을 보인다. 먼저, 

형상계수의 평균은 0.514~0.580으로, 모래하천의 형상계수

로 알려진 0.7 보다는 상당히 작은 값을 보인다. 즉, 입자들이 

(a) a gravel image and its ROI (b) edges detected by Canny method (c) rotated image to find the longest and middle axes

Fig. 3. Image analyses of individual gravel grain

Table 2. Analyzed relationships of test rivers

river section no. of grains avg. shape factor area-weight relationship determination coefficients

Daejong No.59 120 0.585 W = 1.1262 A1.4727 0.9818

Milyang No.65 60 0.540 W = 1.2500 A1.4448 0.9880

Hyungsan No.50 60 0.514 W = 1.3096 A1.4227 0.9898
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상당히 평평한 형태를 띤다는 의미이다. 또 이 때문에, 앞서 

‘자갈이 하상에 놓일 때 단축이 하상면과 수직이 되게 놓인다’

고 가정한 것은 상당부분 적절한 것으로 보인다. 또, 영상 면적

과 무게의 변환관계를 나타내는 이들 회귀식에서 계수는 

1.1262~1.3096, 지수는 1.4227~1.4727로 그 차이가 크지 않

다. 여기서 특히 주목할 것은 지수가 1.4227~1.4727로 앞서 

회전타원체 가정에 의한 Eq. (10)에서 나온 값 1.5보다 약간 

작다는 점이다. 이것은 어느 정도 오차를 용인한다면, 회전타

원체 가정에 의한 영상 분석도 비교적 타당한 결과를 가져올 

수 있다는 의미이기도 하다. 다만, 어느 경우든지 입경이 커질

수록 오차는 커지게 되므로, 특히 입도의 범위가 큰 자갈하천에 

더 정확한 계산을 위해서는 본 연구에서 유도한 식을 이용하

는 것이 타당하리라 생각한다.

이 결과는 이 세 하천뿐만 아니라 다른 하천에서도 거의 비

슷한 경향을 보일 것으로 판단된다. 따라서 이들을 한데 뭉쳐

서 분석하여, 실제로 사용할 수 있는 변환식을 만들었다. 대종

천, 밀양강, 형산강의 총 240개 자료를 모두 이용하여 분석한 

결과는 Fig. 4와 같다. 

또한, 이렇게 종합하여 만들어진 변환식은 다음과 같다.

  (11)

여기서 는 하상재료의 중량(gf)이며, 는 하상재료의 투영

면적(cm2)이다.

또한, 3개 하천 전체의 자료에 대해 실측 무게와 추정 무게를 

함께 도시하면, Fig. 5와 같다. 대부분의 입자들이 실측된 중량과 추

정된 중량 사이에 좋은 상관관계( )를 보여주고 있다. 

3.4 영상에서 개별 입자 분리

하상의 자갈의 입경분포를 영상에서 추정하기 위해서는, 하

상을 촬영한 영상을 개별 입자로 분리하여야 한다. Fig.6은 

Terazawa and Yamazaki (2007)가 조립질 하천의 입도분포 분

석을 위해 촬영한 영상이며, 본 연구에서는 이와 비슷하게 틀을 

제작하여 촬영하였다. 이처럼 촬영된 영상은 약간 기울어져 촬

영된다. 또, Fig.6에서 0.2 m 간격의 격자선은 영상분석에서 방해

가 되므로, 실제 사용하는 영상은 격자선이 없는 상태로 촬영한다. 

또, 사각틀의 크기는 상황에 따라 적절히 조절하여 촬영하였다.

보통 정사영으로 촬영하려면 사다리와 같은 별도의 장비

를 이용해야 한다. 그러나 영상처리에서 사영변환을 이용하

면, 굳이 정사영으로 촬영하지 않아도, 분석이 가능하다. 사영

변환 관계는 2차원 투영좌표 변환법(Pratt, 2007)에 의해 실제 

좌표계 와 영상 좌표계 간의 변환관계를 나타내

며, 다음 식 Eq. (12)와 같다.

 
   

   
(12a)

 
   

   
(12b)

Fig. 4. Relationship between image area and weight of riverbed 
gravels

Fig. 5. Comparison of measured weights and estimated weights of 
riverbed gravels

Fig. 6. Sample image for image analyses of riverbed grains (Terazawa 
and Yamazaki, 2007)
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여기서  (=1, 2, …, 8)는 회전 보정, 병진이동 보정, 좌

표에 대한 직각보정과 평행하지 않은 두 좌표계간의 좌표 보

정을 위한 8개의 사상 계수(mapping coefficients)이다. 이 방

법으로 보정하면 Fig. 7과 같은 영상이 된다. 단, 여기서 격자는 

면적 격자법을 상정하여 가상적으로 화면에 그린 것이다.

정사영으로 변환된 영상에 분수계분할 알고리즘(watershed 

segmentation algorithm)을 적용한다. 분수계분할알고리즘

에 대해서는 영상분석 관련 문헌들(예를 들어, Pratt (2007))에 

많이 제시되어 있다.

분할된 입자들의 영상 면적, 영상 장축, 영상 단축을 분리해 

내고, 여기에 앞서 개별 입자 분석에서 추출된 특성을 적용하

여 각 입자의 중량을 환산한다. 그 다음에 전체 입자를 가장 

가벼운 것부터 차례로 정렬한 뒤, 공칭직경과 누가중량을 구

하고, 이 공칭직경과 누가중량의 관계를 입도 분포도로 작성

한다.

다만, 이 프로그램의 작성은 개별 입자의 분석보다 훨씬 어

렵고 시간이 많이 걸리는 작업이다. 따라서 본 연구에서는 독

자적인 프로그램을 작성하지 않고, 인터넷에서 공공으로 배

포되는 ImageJ 프로그램을 이용하였다. ImageJ는 인터넷

(https://imagej.nih.gov/ij/)에서 손쉽게 내려받을 수 있다.

ImageJ를 이용하여 입도 분포를 조사하는 과정을 간략히 

나타내면, Fig. 8과 같다. 

① 먼저 ImageJ 프로그램을 실행하고, File > Open을 클릭

한 후 원하는 영상을 선택한다

② 자갈을 계수하는 방법은 두 가지가 있으나 결과값에는 

그다지 차이가 나지 않는다. 그래서 간편하고 빠른 방법

으로 이미지를 Image > Type > 8-비트로 변환한다

③ 그런 다음에 Image > Adjust > Threshold를 이용하여 

영역을 나누어준다. 그리고 마지막 Apply를 적용하면 

반전이 되면서 자갈의 경계를 나눠준다.

④ 그리고 Analyze > Aanalyze particles를 클릭하여 분석

하기 전 변수를 설정한다. Size (pixel^2)는 이 필드에 지

정된 범위를 벗어난 크기와 입자는 무시되며, 내정값은 

0-infinity이다. 앞자리는 수정이 되며 0에 가까울수록 

작은 부분까지 나타내고 커질수록 작은 부분은 무시되어

진다. Circularity는 이 필드에 지정된 범위를 벗어나는 

크기의 원형도 값을 말하며, 0은 무한대로 연장된 다각

형에서 1은 완전한 원형까지의 범위이다. Show는 분석 후 

Fig. 7. Sample image after perspective transform (a) sample image

(b) sample image inversed with threshold value

(c) outlines of indivisual grains 

(d) analyzed results 

Fig. 8. Procedure of grain separation with ImageJ
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표시를 지정하는 곳이며 자갈 계수를 위해서는 Outline을 

적용한다. 

⑤ 이런 과정을 거치면 최종적으로 결과는 Fig. 8(d)와 같은 

표로 나타난다. 마지막으로 결과값의 면적은 화소 단위

로 나타낸 것이므로 cm2으로 단위변환을 해야 한다.

⑥ Fig. 8(d)의 결과 값을 그래프로 그리고, 과 같은 입도

분포 특성을 추출한다. 그런데, 일반적인 입경 분포 곡선

은 가로축이 입자 직경(mm)이고, 세로축이 누적통과중

량 백분율(%)이다. 그런데, ImageJ에 의해 분석한 하상 재

료 분석결과에는 입자의 면적만이 제시된다. 따라서, 이 면

적을 중량과 직경(여기서는 공칭직경)으로 나타낼 수 있는 

방법이 필요하다. 여기서 앞서 구해 놓은 입자의 투영면적

과 중량과의 관계식 Eq. (11)을 이용한다. 그런데, 입자를 

구로 가정하면, 중량과 공칭직경은 다음의 관계를 가진다.







 (13)

여기서 는 입자의 중량(g), 은 입자의 단위중량(gf/cm3), 

는 입자의 체적(cm3), 은 입자의 공칭직경(cm)이다. 만

일  = 2.65 (gf/cm3)을 이용하고, 공칭직경을(mm)로 나타내

면, 이 식은 다음 Eq. (14)와 같다.

 





(14)

따라서, 여기에 앞의 Eq. (11)을 적용하여 무게로 환산하고, 

Eq. (14)를 적용하여 공칭직경으로 나타낸다. 이렇게 구한 공

칭직경과 무게를 작은 것부터 크기순으로 차례로 정렬하여 

누가중량으로 표시하면 입도분포도가 완성된다.

3.5 시험 구간에 적용

개발된 방법을 대종천, 형산강, 밀양강의 세 지점에 적용하였

다. 각 지점에서 각 1매의 사진을 촬영하고, 비교를 위해 그 지점

의 표면시료를 약 10 cm 깊이까지 채취하였다. 채취한 시료는 

실험실로 운반하여 체가름 시험을 하여 입도분포를 작성하였다.

먼저 대종천에 대한 자료를 살펴 보면 다음과 같다. 대종천

에서 촬영한 사진과 분석한 결과는 Fig. 9와 같다. 이 때 Fig. 

9(a)의 사각틀의 크기는 50 cm × 50 cm이다. Fig. 9(a)를 영상 

분석한 결과는 Fig. 9(b)와 같다. 또, Fig. 9(b)에는 이 부분의 

하상재료를 표면에서 약 10 cm 깊이로 채취하여 체분석하여 

얻은 결과를 검정 파선으로 표시하였다. Fig. 9(b)를 보면, 영

상분석 결과와 실측 결과는 비교적 적절히 일치함을 알 수 있

다. 중앙입경 을 살펴보면, 영상분석의 결과와 실측 모두 

40 mm로 거의 비슷한 값을 보인다. 또, 이 결과에서는 Table 1에 

보인 기존 자료의 이 4.2 mm라는 결과가 얼마나 터무니없

는 크기인지를 알 수 있다. 이처럼 영상분석 결과는 중간 부분

에서는 비교적 적절한 결과를 보이나, 점선의 타원으로 표시

한 20 mm 이하의 작은 입자와 60 mm 이상의 매우 큰 입자에서 

비교적 차이가 큰 결과를 보인다. 이것은 먼저 20 mm 이하의 

작은 입자의 경우, ImageJ를 이용한 입도분석에서 어느 이하

로 작은 입자들을 제거하도록 하였기 때문에 분석에서 누락된 

결과로 보인다. 이 경우 이 부분을 보다 잘 일치시키기 위해 

제거되는 작은 입자쪽의 크기 한계를 늘리면, 영상 잡음에 따

른 오차가 많이 생겨서 이번에는 중간크기 입자 부분의 일치

도가 떨어진다. 따라서 영상잡음과 분석 한계 사이에서, 중간

크기 입자부분에 보다 중점을 두고 결정한 결과가 바로 Fig. 

9(b)이다. 한편, 60 mm 이상의 큰 입자에서 생긴 오차는 영상

분석과정에서 매우 큰 입자 한둘이 포함되는가 여부에 따라 

발생하는 것으로 보인다. 아니면, 조립질 입자에 대한 가정에서 

(a) image of riverbed gravels (b) grain size distribution

Fig. 9. Grain size distribution of the Daejong River 
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‘자갈이 하상에 놓일 때, 단축이 하상면과 수직이 되게끔 놓인

다’는 가정이 위배될 경우에도 큰 입자에서 이처럼 오차가 큰 

결과가 생겼을 가능성도 있다.

Fig. 10(b)을 보면, 밀양강 자료에서 영상분석 결과와 실측 결

과는 비교적 잘 일치함을 알 수 있다. 특히 중간 부분 이상에서는 

매우 근접한 결과를 보인다. 중앙입경 을 살펴보면, 영상분석

의 결과와 실측은 각각 50 mm와 55 mm로 거의 비슷한 값을 보인

다. 이 경우 의 측정 오차는 10%이다. 아울러 앞서 Table 1에

서 보인 것처럼, 약 7 mm 내외라는 기존 하천정비기본계획의 결

과가 얼마나 오류가 큰지를 알 수 있다. 다만, 대종천의 경우와 

마찬가지로, 30 mm 이하의 작은 입자에서 비교적 차이가 크다.

세번째로 형산강에 대한 자료를 살펴 보면, 형산강에서 촬

영한 사진과 분석한 결과는 Fig. 11과 같다. Fig. 11(b)을 보면, 

형산강 자료에서는 밀양강 자료와 비슷한 경향을 보인다. 즉, 

큰 입자 영역의 분석결과는 상당히 유사하나, 세립질 영역의 

결과는 비교적 큰 차이를 보인다. 중앙입경 을 살펴보면, 

영상분석의 결과와 실측은 각각 84 mm와 77 mm로 비교적 

근접한 결과를 보인다. 다만, Fig. 11(b)에 점선 타원으로 표시

한 40 mm 이하의 작은 입자 부분은 비교적 차이가 크다. 

이러한 결과에서 유추할 수 있는 것은, 영상입도분석은 모

래와 같은 세립토사나 거력 이상의 조립토사에서는 오차가 

비교적 크게 발생할 수 있다는 점이다. 두 경우의 오차 발생 

요인은 서로 다르다. 세립토사의 경우, 크기가 작아 개별적으

로 입자 하나하나를 분석할 수 없으며, 정확한 측정이 어렵다. 

이런 점은 앞서 언급한 상호상관에 의한 입도분석법을 이용하

면 해결할 수 있을 것이다. 반면, 거력 이상의 조립토사에 따른 

문제는 입자가 커서 실제 하상표면에 입자 일부만 드러난 경

우도 있고, 또 다른 입자에 가려서 원래의 크기보다 작게 나타

나거나, 다른 입자와 구별하기 힘든 경우가 있다. 이런 부분은 

본 연구에서 시도한 영상분석 방법으로는 특별한 해결 방법을 

찾기 힘들다. 다만, 현장별로 사전에 조사를 하여, Eq. (11)을 

개량하면 정확도를 높일 수 있을 것으로 기대한다.

(a) image of riverbed gravels (b) grain size distribution

Fig. 10. Grain size distribution of the Milyang River 

(a) image of riverbed gravels (b) grain size distribution

Fig. 11. Grain size distribution of the Hyungsan River 



K. Yu and W. Cho / Journal of Korea Water Resources Association 52(7) 493-503502

4. 요약 및 결론

본 연구의 목적은 자갈 이상의 조립질 재료로 이루어진 하상

의 입도 분포를 영상 처리를 통하여 분석하는 기법을 개발하는 

것이다. 이를 위하여 다음과 같은 분석과 연구를 수행하였다.

1) 영상입도분석 기법을 개발하기 위한 일단계로서, 먼저 개

별 입자들의 영상에 나타난 평면 특성(장축, 중간축, 면적 

등)이 실제 입자와 어떤 관계를 가지는가 분석하였다. 이

를 위하여, 3개 하천에서 240개의 자갈 시료를 채취한 뒤, 

각 입자의 버니어캘리퍼스로 장축, 중간축, 단축의 길이를 

측정하고, 저울로 중량을 측정하였다. 

2) 채취된 입자를 개별적으로 영상으로 찍은 후, 영상에서 장

축과 중간축, 면적을 계측하는 프로그램을 개발하였다. 채

취한 240개 입자를 영상으로 측정하고, 앞서 버니어캘리퍼

스와 저울로 측정한 자료와 비교하였다. 그 결과 자갈의 중

량은 장축이나 중간축의 크기보다는 면적과의 상관성이 

더 높다. 따라서, 영상 분석에서 나온 면적을 입자의 중량으

로 환산하는 것이 더 타당할 것으로 보인다. 이 방법은 기존

의 연구에서 타원체 가정을 한 것보다 나은 결과를 보인다.

3) 조립질 재료로 이루어진 하상을 촬영한 뒤, 영상 분할 프로

그램인 ImageJ 프로그램을 이용하여, 개별 입자를 분리하

고 이 입자들의 중량을 추정하여 입도를 분석하였다. 

이러한 연구를 바탕으로 얻은 결론은 다음과 같다.

1) 입자의 개별 측정 결과 자갈 하천의 하상 재료의 형상계수

는 약 0.6 이하이었다. 이는 모래 하상의 0.7, 자갈 하천이 

이보다 약간 작다는 통상적으로 알려져 있는 지식과 부합

하였다. 또한, 하천에 따라 형상계수는 약간의 차이를 보이

기 때문에 일괄적으로 통일된 값을 적용하기는 어려울 것

으로 보인다. 

2) 또, 개별 입자의 분석에서, 자갈의 중량은 장축이나 중간축

의 크기보다는 면적과의 상관성이 더 높다. 따라서, 영상 

분석에서 나온 면적을 입자의 중량으로 환산하는 것이 더 

타당할 것으로 보인다. 

3) 개발된 방법을 3개 하천 현장에 적용한 결과, 두 하천의 경

우 영상에서 추정된 중앙 입경은 실측된 입경과 10% 내외

의 오차를 가지고 있으며, 입도곡선을 비교적 적절히 추정

할 수 있었다. 다만, 작은 입자의 경우, 영상분석에 의한 입도 

추정은 상당히 큰 오차를 보이며, 이를 해결하기 위해서는 

새로운 방법이 필요하다. 또, 매우 큰 입자의 분포에서는 한

두 개의 입자가 전체 시료 중에서 차지하는 비중이 지나치게 

커서 입도 분포를 왜곡시킬 수 있음을 발견하였다. 

4) 본 연구에서 개발된 방법은 몇 가지 미비점을 적절히 보완할 

경우, 이 방법을 현장에 충분히 적용할 수 있음을 보였다.
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